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QUICKSTART GUIDE (ENGLISH) 
 
1. Make sure all items listed in the Box Contents are 

included. 
2. READ SAFETY INSTRUCTION BOOKLET BEFORE 

USING THE PRODUCT. 
3. Place the product in an appropriate location for operation. 
 
 
 
 
 
 
 
 
 

PICKUP INSTALLATION 
 
To install the pickup to your 
guitar’s soundhole: 
 
1. Carefully loosen the pickup 

clamps clockwise with a 
screwdriver.  

2. Position the pickup in the 
soundhole, near the end of the 
fretboard.  

3. Re-tighten the pickup clamps 
counter-clockwise. 

 
 
 
 
 
 

BOX CONTENTS 

 Single coil acoustic guitar 
pickup 

 GuitarLink USB guitar 
cable 

 Quickstart Guide 
 Safety Instructions & 

Warranty Information 
Booklet 

 Cubase LE DVD 
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CONNECTION DIAGRAM 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Before beginning, make sure your computer meets these system requirements: 
• Windows: Microsoft Windows XP (SP2) / Vista (32- or 64-bit) / 7 (32- or 64-bit) with Pentium-IV or 
Athlon XP, 1.6GHz or higher (recommended) 
• Mac: Apple Mac OSX 10.5 above 
• 1 GB RAM or above (recommended) 
• Sound card (AC97-compatible sound card) 
• 1GB free hard drive space 
• DVD-ROM drive (for software installation) 
• One available USB 2.0 port (preferably on the rear panel of your computer) 
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ABOUT AUDIO LATENCY 
 
“Latency” is the time it takes for your computer’s soundcard to process incoming data and output a 
sound. The lower your latency is, the faster your computer will respond to commands and output 
sound. 
If you experience significant delay between the time you play and the time that the computer outputs 
audio, we recommend going into your software’s “Preferences” settings to make sure that your 
soundcard’s latency (or buffer) is set to a low number – ideally lower than 15-20ms. 

 

1. ASIO INSTALLATION (WINDOWS) 
IVER INSTALLATION (WINDOWS USERS) 
1. Download and Install the free ASIO4ALL driver from www.asio4all.com. This will allow for low 
latency performance.   
2. Double click the installer file (.exe). Follow the on-screen prompts to install the included low latency 
ASIO4ALL driver.  
 
2. AUDIO SETUP (WINDOWS AND MAC) 
 
In most cases (especially if you are using Windows) AcousticLink will be automatically selected as your 
computer’s default recording device. If you find you are unable to record any audio with AcousticLink, 
follow the instructions below for your operating system. 
You can use AcousticLink with any digital audio workstation or recording software that supports USB 
audio devices. Be sure your audio software program is set up to receive audio via AcousticLink. Please 
consult your software program’s manual for more information.   
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WINDOWS 7 
 
1. Go to Start Menu  Control Panel  Hardware and Sound  Sound.   

2. Select the “Recording” tab. 

3. Make sure Microphone – USB PnP Sound Device is set as the default device, then click “OK.”  

4. Make sure your internal soundcard (ie. SoundMax, Conexant, etc.) is set as the default playback 
device, then click “OK.” 

 
 WINDOWS VISTA 
 
1. Go to Start Menu  Control Panel  Sound.  (If you don’t see Sound, select “Switch to Classic 

View,” and the Sound Control Panel should become available.) 

2. Select the “Recording” tab. 

3. Make sure USB PnP Sound Device is set as the default recording device. 

4. Make sure your internal soundcard (ie. SoundMax, Conexant, etc.)  is set as the default playback 
device, then click “OK.” 

 WINDOWS XP 
 
1. Go to Start Menu  Control Panel  Sounds and Audio Devices. 
2. Click the “Audio” tab. 

3. Under “Sound Recording,” make sure USB PnP Sound Device is selected as the default 
recording device. 

4. Under “Sound Recording,” make sure your internal soundcard (ie. SoundMax, Conexant, etc.) is 
selected as the default playback device, then click “OK.” 
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 MAC (OSX 10.5) 
 
1. Click on the Mac desktop so that Finder is 
displayed in the upper-left of the screen. 
2. Select the Go menu from the top of the 
screen and choose Utilities. 
3. In the window that opens, double click 
Audio MIDI Setup. 
4. In the Audio menu, select Open Aggregate 
Device Editor. 
5. Click on the + sign to create an Aggregate 
Device.  
6. Put a check mark in the boxes for USB PnP 
Sound Device and Built-in Output and click 
Done. 
7.  In the “Audio Devices” tab under “System 
Settings,” select Aggregate Device as your 
Default Input.  
8. For the Default Output, select Built-in 
Output then close the window. 
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MAC (OSX 10.6) 
 
 Set Acousticlink as your default recording device:  
 
1. Click on the Mac desktop so that Finder is 
displayed in the upper-left of the screen. 
2. Select the Go menu from the top of the screen 
and choose Utilities. 
3. In the window that opens, double click Audio 
MIDI Setup. 
4. Once the Audio MIDI Setup utility is open, 
select the Window menu  at the top of the screen 
and select ’Show Audio Window’.  
5. In the window that opens, click the + button to 
create an aggregate device. 
6. Highlight the Aggregate Device in the left panel 
and then put a check mark in the box on 
 the right side panel for USB PnP Sound Device  
as well as Built-in Output.  
7. Make sure Aggregate Device is highlighted in 
the left panel and then click on the cog wheel. 
Select ‘Use this device for sound input’.  
8. Highlight the Built-In output option in the left 
panel, click the cog wheel and select ‘Use this 
device for sound output’.  
9. Close out of the Audio Setup window. 
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3. SETTING UP THE SOFTWARE (WINDOWS AND MAC) 
 
ACTIVATING CUBASE LE 5 
 
1. Install Cubase LE 5.  
2. Make sure that your computer has a working Internet connection to activate the license because 

the eLicenser Control Center (eLCC) needs to register with the Steinberg license server.  
3. Make sure that you have the latest version of the eLCC installed from www.elicenser.net.  
4. Open the eLicense Control Center (eLCC) software and make a note of your Soft-eLicenser 

number. If you do not see your number, click the "Support" menu and select "Update eLicenser 
License Database."  

5. Create a user account in the MySteinberg area at www.steinberg.net. If you already have one, 
please go to Step 7. 

6. Check your email and activate your user account by clicking the link in the confirmation email. If 
the link does not work, copy and paste the link into your browser's address bar. 

7. Log in to your MySteinberg account, and click on "Activation & Reactivation", choose "Cubase 
LE 5" and select "Permanent Activation". Enter your Soft-eLicenser and choose your hardware 
manufacturer.  

8. You will receive an email containing the activation code.  
9. Launch the eLicenser Control Center software. Click the "Enter Activation Code" button to 

download the license for your Steinberg product to the Soft-eLicenser. Enter the required 
activation code into the corresponding field. Follow the instructions on screen. 

10. After activating your software, open Cubase to begin using it. 
 
Attention, Windows Users: If you see a "permissions" error message when trying to open the 
software, follow these steps: 
1. Right-click the Cubase icon on your Desktop. 
2. Select Properties. 
3. Select the Compatibility tab. 
4. Under "Privilege Level," check the box that says "Run this program as an administrator." 
5. Click "Apply" then "OK."  



  

10 

 

WINDOWS SETUP 
 
Once Cubase LE 5 is installed and activated, 
follow the steps below to configure the software 
to record with the AcousticLink.   
 
1. Open Cubase LE 5. If prompted to open a 

project, cancel for now. 
2. From the menus select Devices  Device 

Setup. 
3. In Device Setup click on VST Audio System.  
4. In the ASIO driver dropdown box, select 

ASIO4ALL.  When asked to switch the driver, 
select ‘Yes’. Then select ASIO4ALL from the 
left panel and click on the Control Panel 
button at the top right of the window. 

5. Click on the image of the wrench in the 
bottom right corner and ensure that USB PnP 
Sound Device is selected for the 
input device and your internal 
soundcard is selected as the output 
device. Uncheck any other devices 
listed here. 

6. Click OK for the two windows that 
are open, and then close and reopen 
Cubase for the changes to take 
effect.  

7. In Cubase, click on File New 
Project and select Empty, and 
choose where you would like to save 
your project.  
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8. Click on the Device menu at the top of the screen and 

select VST Connections. Click on Inputs at the top of the 
window. Click on the input titled under the Bus Name 
column and press the delete key on your keyboard to 
delete the Stereo In bus. The VST connections window 
should now be empty. Create a Mono input bus by clicking 
on the Add Bus button and selecting the Mono 
configuration. Name the preset, and click OK.  

9. Under the Audio Device column, select ASIO4ALL. 
10. In the Device port column, select ‘Sound Device 1’ (Mono 

in).  
11. Click on the Outputs tab, select ‘ASIO4ALL’ as the 

Audio Device. 
12. In the Device port column, select your internal 

soundcard as the output device. Close the VST 
Connections window. 

13. Right click in the main project window and choose Add 
Audio Track. 

14. In the Audio Track Configuration window, select ‘1 – 
Mono’ and click OK. 

15. Activate the Track Monitor button on the Mono 
track, found next to the Record Enable button. 
Click the Record button at the top of the Cubase 
window, do a quick test, and stop the recording.  

16. Rewind to the beginning of the track and press 
the play button at the top of the Cubase window 
to hear what you just recorded. 

 
Note: To avoid having to set the VST Audio System and 
VST Connections each time you open Cubase, you can 
save a your settings as a template by going to File> Save  
as Template. Then when you reopen Cubase your template 
 will appear in the Project Templates list.  
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MAC SETUP  
  
Once Cubase LE is installed and activated, follow 
the steps below to configure the software to 
record with the AcousticLink.   
 
1. Open Cubase LE. If prompted to open a 

project, cancel for now. 
2. From the menus select  Devices> Device 

Setup. 
3. In Device Setup click on VST Audio 

System.  
4. In the ASIO driver list on the right side of 

the Device Setup, select Aggregate 
Device. Click OK. 

5. In Cubase, click on File New Project and 
select Empty, and choose where you 
would like to save your project.  

6. Click on the Device menu at the top of the 
screen and select VST Connections. Click 
on Inputs at the top of the window. Click on 
the input titled under the 
Bus Name column and 
press the delete key on 
your keyboard to delete 
it. The VST connections 
window should now be 
empty. Next, you will 
create a Mono input bus. 
Click on the Add Input 
Bus button. Name the 
preset, and click OK. 
Close the VST 
Connections window. 
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7. Right click in the dark blue area of the main project and choose Add Audio Track. 
8. In the Audio Track Configuration window, select 1 – Mono and click OK. 
9. Activate the Track Monitor button on the Mono track, found next to the Record Enable button. 

Click the Record button at the top of the Cubase window, do a quick test, and stop the recording.  
10. Rewind to the beginning of the track, disable the track monitor button and then press the play 

button at the top of the Cubase window to hear what you just recorded.  
 
Note: To avoid having to set the VST Audio System and VST Connections each time you open 
Cubase, you can save a your settings as a template by going to File> Save as Template. Then when 
you reopen Cubase your template will appear in the Project Templates list. 
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GUÍA DE INICIO RÁPIDO (ESPAÑOL) 
 
1. Asegúrese de que estén presentes todos los elementos 

enumerados en Contenido de la caja. 
2. LEA EL FOLLETO DE INSTRUCCIONES DE 

SEGURIDAD ANTES DE UTILIZAR EL PRODUCTO. 
3. Coloque el producto en un lugar adecuado para su 

funcionamiento. 
 
 
 
 
 
 
 
 
 

INSTALACIÓN DEL CAPTOR 
 
Para instalar el captor en la boca 
de la guitarra: 
 
1. Afloje cuidadosamente las 

abrazaderas del captor en 
sentido horario con un 
destornillador.  

2. Posicione el captor en la boca 
de la guitarra, cerca del 
extremo del mástil de los 
trastes.  

3. Vuelva a apretar las 
abrazaderas del captor en 
sentido horario. 

 
 
 

 Captor para guitarra 
acústica de una sola 
bobina 

 Cable para guitarra USB 
GuitarLink 

 Guía de inicio rápido 
 Folleto de instrucciones de 

seguridad e información 
sobre la garantía 

 DVD de Cubase LE 
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DIAGRAMA DE CONEXIÓN 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Antes de comenzar, asegúrese de que su computadora cumpla estos requisitos de sistema: 
• Windows: Microsoft Windows XP (SP2) / Vista (de 32 ó 64 bits) / 7 (de 32 ó 64 bits) con Pentium-IV 
o Athlon XP, de 1.6 GHz o superior (recomendado) 
• Mac: Apple Mac OSX 10.5 o superior 
• 1 GB de RAM o más (recomendado) 
• Tarjeta de sonido (compatible con AC97) 
• 1 GB de espacio libre en disco duro 
• Lector de DVD-ROM (para la instalación del software) 
• Un puerto USB 2.0 disponible (preferiblemente en el panel trasero de la computadora) 
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ACERCA DE LA LATENCIA DE AUDIO 
 
“Latencia” es el tiempo que demora la tarjeta de sonido de la computadora para procesar los datos 
entrantes y producir un sonido de salida. Cuando más baja es la latencia, más rápido responde su 
computadora a los comandos para producir sonido. 
Si experimenta un retardo significativo entre el momento en que usted toca y el momento en que la 
computadora produce audio, recomendamos entrar en los parámetros “Preferences” (Preferencias) de 
su software para asegurarse de que la latencia (o búfer) de la tarjeta de sonido esté ajustada a un 
número bajo —idealmente inferior a 15-20 ms. 

 

1. ASIO INSTALACIÓN (WINDOWS) 
IVER INSTALLATION (WINDOWS USERS) 
1. Descargue gratuitamente el driver ASIO4ALL (Entrada/salida de corriente de audio) para PC de 
www.asio4all.com.  
2. De doble clic en el archivo de instalación (.exe). 
3. Siga las instrucciones en pantalla para instalar el controlador de audio. 
 
2. CONFIGURACIÓN DE AUDIO (WINDOWS AND MAC) 
 
En la mayoría de los casos (especialmente si está usando Windows) AcousticLink será seleccionado 
automáticamente como dispositivo de grabación predeterminado de su computadora. Si observa que 
no puede grabar ningún audio con AcousticLink, cumpla las siguientes instrucciones correspondientes 
a su sistema operativo. 
Puede usar AcousticLink con cualquier estación de trabajo de audio digital o software de grabación 
que soporte dispositivos de audio USB. Además, asegúrese también de que su programa de software 
de audio esté configurado para recibir audio por AcousticLink. Para más información, consulte el 
manual del software.   
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WINDOWS 7 
 
1. Vaya al menú Start  Control Panel  Hardware and Sound  Sound (Inicio > Panel de 

Control > Hardware y sonido > Sonido).   

2. Seleccione la pestaña “Recording” (Grabación). 

3. Asegúrese de que Microphone – C-Media USB Audio Device (Micrófono – Dispositivo de 
audio USB C-Media) esté configurado como dispositivo predeterminado y haga clic en “OK” 
(Aceptar).  

4. Asegúrese de que su tarjeta de sonido interna esté configurada como dispositivo de 
reproducción predeterminado y haga clic en “OK” (Aceptar). 

 
 WINDOWS VISTA 
 
1. Vaya al menú Start  Control Panel  Sound (Inicio > Panel de control  Sonido).  (Si no ve 

Sound, seleccione “Switch to Classic View” (Cambiar a vista clásica) —el panel de control 
Sound debe aparecer.) 

2. Seleccione la pestaña 
“Recording” (Grabación). 

3. Asegúrese de que Microphone – C-Media USB Audio Device (Micrófono – Dispositivo de 
audio USB C-Media) esté configurado como dispositivo de grabación predeterminado. 

4. Asegúrese de que su tarjeta de sonido interna esté configurada como dispositivo de 
reproducción predeterminado y haga clic en “OK” (Aceptar). 

 WINDOWS XP 
 
1. Vaya al menú Start  Control Panel  Sounds and Audio Devices (Inicio  Panel de control 

> Dispositivos de sonido y audio). 

2. Haga clic en la pestaña “Audio”. 

3. Bajo “Sound Recording" (Grabación de sonido), asegúrese de que C-Media USB Audio 
Device (Dispositivo de audio USB C-Media) esté configurado como dispositivo predeterminado. 

4. Bajo “Sound Recording” (Grabación de sonido), asegúrese de que su tarjeta de sonido interna 
(SoundMax, Conexant, etc.) esté seleccionada como dispositivo de reproducción 
predeterminado y haga clic en “OK” (Aceptar).  
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 MAC (OSX 10.5) 
 
1. Haga clic en el escritorio de Mac de modo que 
aparezca Finder Buscador) en la parte superior 
izquierda de la pantalla. 
2. Seleccione el menú Go (Ir) en la parte superior de 
la pantalla y elija Utilities (Utilidades. 
3. En la ventana que se abre, haga doble clic en 
Audio MIDI Setup (Configuración MIDI de audio). 
4. En el menú Audio, seleccione Open Aggregate 
Device Editor (Abrir editor de dispositivos agregado). 
5. Haga clic en el signo + para crear un dispositivo 
agregado.  
6. Coloque una marca de selección en la casilla 
correspondiente a  USB PnP Sound Device 
(Dispositivo de sonido PnP USB) y Built-in Output 
(Salida incorporada) y haga clic en Done (Hecho). 
7.  En la pestaña “Audio Devices” (Dispositivos de 
audio) bajo “System Settings” (Parámetros del 
sistema, seleccione Aggregate Device   
(Dispositivo agregado) como Default Input (Entrada 
predeterminada).  
8. Como Default Output (Salida predeterminada), 
seleccione Built-in Output (Salida incorporada) y 
cierre la ventana. 

. 
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MAC (OSX 10.6) 
 
 Configure Acousticlink como dispositivo de 
grabación predeterminado.  
 
1. Haga clic en el escritorio de Mac de modo que 
aparezca Finder Buscador) en la parte superior 
izquierda de la pantalla. 
2. Seleccione el menú Go (Ir) en la parte superior 
de la pantalla y elija Utilities (Utilidades. 
3. En la ventana que se abre, haga doble clic en 
Audio MIDI Setup (Configuración MIDI de 
audio). 
4. Una vez que esté abierta la utilidad Audio 
MIDI Setup , seleccione el menú Window 
(Ventana) de la parte superior de la pantalla y 
seleccione ’Show Audio Window’ (Mostrar 
ventana de audio).  
5. En la ventana que aparece, haga clic en el 
botón + para crear un dispositivo agregado. 
6. Resalte el dispositivo agregado en el panel 
izquierdo y  coloque una marca de selección en 
la casilla del  panel del lado derecho 
correspondiente a USB PnP Sound Device 
como también Built-in Output.  
7. Asegúrese de que Aggregate Device 
(Dispositivo agregado) esté resaltado en el panel 
izquierdo y luego haga clic en la rueda dentada. 
Seleccione “Use this device for sound input” 
(Usar este dispositivo para entrada de sonido).  
8. Resalte la opción de salida Built-In 
(Incorporada) del panel izquierdo, haga clic en la 
rueda dentada y seleccione “Use this device for 
sound output” (Usar este dispositivo como salida 
de sonido).  
9. Cierre la ventana Audio Setup (Configuración de audio). 
 
 



  

20 

3. CÓMO CONFIGURAR EL SOFTWARE 
 
CÓMO ACTIVAR CUBASE LE 5 
 
1. Instalación de Cubase LE.  
2. Asegúrese de que su computadora tenga una conexión a Internet en funcionamiento para 

activar la licencia, puesto que eLicenser Control Center (eLCC) necesita registrarse con el 
servidor de licencias Steinberg.  

3. Asegúrese de tener instalada la versión más reciente de eLCC de www. elicenser.net.   
4. Abra el software eLicense Control Center (eLCC) y tome nota de su número de Soft-eLicenser. 

Si no ve su número, haga clic en el menú "Support" (Soporte) y seleccione "Update eLicenser 
License Database" (Actualizar base de datos de licencias de eLicenser).  

5. Cree una cuenta de usuario en el área MySteinberg en www.steinberg.net.  Si ya tiene una, 
vaya al paso 7. 

6. Compruebe su correo electrónico y active su cuenta de usuario haciendo clic en el enlace que 
aparece en el correo electrónico de confirmación. Si el enlace no funciona, copie y pegue el 
mismo en la barra de direcciones de su navegador. 

7. Inicie sesión en su cuenta de MySteinberg y haga clic en "Activation & Reactivation" (Activación 
y reactivación), elija "Cubase LE 5" y seleccione "Permanent Activation" (Activación 
permanente). Ingrese a su Soft-eLicenser y elija su fabricante de hardware.  

8. Recibirá un correo electrónico de confirmación que contiene el código de activación.  
9. Abra el software eLicenser Control Center. Haga clic en el botón "Enter Activation Code" 

(Ingresar código de activación) para descargar la licencia correspondiente a su producto 
Steinberg al Soft-eLicenser. Ingrese el código de activación requerido en el campo 
correspondiente. Siga las instrucciones de la pantalla. 

10. Después de activar su software, puede abrir Cubase y comenzar a usarlo. 
 
Atención usuarios de Windows: Si ve un mensaje de error de "permissions" (permisos) cuando 
tratar de abrir el software, siga estos pasos: 
1. Haga clic derecho en el icono de Cubase de su escritorio. 
2. Seleccione Properties (Propiedades). 
3. Seleccione la pestaña Compatibility (Compatibilidad). 
4. En "Privilege Level" (Nivel de privilegio), marque la casilla que dice "Run this program as an 

administrator" (Ejecutar este programa como administrador). 
5. Haga clic en "Apply" (Aplicar) y luego en "OK" (Aceptar). 
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CONFIGURACIÓN PARA WINDOWS 
 
Una vez que está instalado y activado Cubase 
LE 5, siga los pasos abajo indicados para 
configurar el software para grabar con 
AcousticLink.   
 
1. Si se le solicita abrir un proyecto, abra 

Cubase LE 5. 
2. En los menús, seleccione Devices  

Device Setup (Dispositivos > 
Configuración de dispositivos. 

3. En Device Setup, haga clic en VST Audio 
System(Sistema de audio VST).  

4. En el cuadro desplegable del driver ASIO, 
seleccione ASIO4ALL.  Cuando se le 
solicite cambiar el driver, seleccione ‘Yes’ 
(Sí). Luego seleccione ASIO4ALL en el 
panel izquierdo y haga clic en el 
botón Control Panel (Panel de 
control) de la parte superior 
derecha de la pantalla. 

5. Haga clic en la imagen de la llave 
inglesa de la esquina inferior 
derecha y asegúrese de que USB 
PnP Sound Device (Dispositivo 
de sonido PnP USB) esté 
seleccionado como dispositivo de 
entrada y que su tarjeta de sonido 
interna esté seleccionada como 
dispositivo de salida. Deseleccione todos los demás dispositivos aquí enumerados. 
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6. Haga clic en OK en las dos ventanas que están abiertas y 

luego cierre y vuelva a abrir Cubase para que los cambios 
tengan efecto.  

7. En Cubase, haga clic en File New Project (Archivo > 
Nuevo proyecto), seleccione Empty (Vacío), y elija dónde 
desea guardar su proyecto.  

8. Haga clic en el menú Device (Dispositivo) de la parte 
superior de la pantalla y seleccione VST Connections 
(Conexiones VST). Haga clic en Inputs (Entradas) en la 
parte superior de la pantalla. Haga clic en la entrada 
titulada debajo de la columna Bus Name (Nombre del bus) 
y pulse la tecla de eliminar de su teclado para eliminar 
el Stereo In bus (Bus de entrada estéreo). La ventana 
de conexiones VST debe quedar vacía ahora. Cree un 
bus de entrada mono haciendo clic en el botón Add 
Bus (Agregar bus) y seleccionando la configuración 
Mono. Asigne nombre al preset y haga clic en OK.  

9. En la columna Audio Device (Dispositivo de audio), 
seleccione ASIO4ALL. 

10. En la columna Device Port (Puerto del 
dispositivo), seleccione ‘Sound Device 1’ 
(Dispositivo de sonido 1) (entrada mono).  

11. Haga clic en la pestaña Outputs (Salidas) y 
seleccione ‘ASIO4ALL’ como dispositivo de 
audio. 

12. En la columna Device Port, seleccione su tarjeta 
de sonido interna como dispositivo de salida. 
Cierre la ventana VST Connections. 

13. Haga clic derecho en la ventana principal del 
proyecto y seleccione Add Audio Track (Agregar 
pista de audio). 

14. En la ventana Audio Track Configuration (Configuración de pista de audio), seleccione ‘1 – 
Mono’ y haga clic en OK (Aceptar). 

15. Active el botón Track Monitor (Monitor de pista) en la pista Mono, que se encuentra junto al 
botón Record Enable (Activar grabación). Haga clic en el botón Record (Grabar) de la parte 
superior de la ventana de Cubase, efectúe una prueba rápida y detenga la grabación.  

16. Rebobine hasta el comienzo de la pista y pulse el botón de reproducir de la parte superior de la 
ventana de Cubase para oír lo que acaba de grabar. 
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Nota: Para evitar tener que configurar VST Audio System y VST Connections cada vez que abra 
Cubase, puede guardar su configuración como plantilla yendo a File> Save as Template (Archivo > 
Guardar como plantilla). Luego, cuando reabra Cubase, su plantilla aparece en la lista Project 
Templates (Plantillas del proyecto).  
 

CONFIGURACIÓN PARA MAC  
  
Una vez que está instalado y activado Cubase 
LE, siga los pasos abajo indicados para 
configurar el software para grabar con 
AcousticLink.   
 
1. Abra Cubase LE. Si se le solicita abrir un 

proyecto, cancele por ahora. 
2. En los menús, seleccione Devices > 

Device Setup (Dispositivos > 
Configuración de dispositivos. 

3. En Device Setup, haga clic en VST Audio 
System(Sistema de audio VST).  

4. En la lista de drivers ASIO del lado derecho 
de Device Setup, seleccione Aggregate 
Device(Agregar dispositivo). Haga clic en 
OK (Aceptar). 

5. En Cubase, haga clic en File New 
Project (Archivo > Nuevo proyecto), 
seleccione Empty (Vacío), y elija dónde 
desea guardar su proyecto.  
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6. Haga clic en el menú 

Device (Dispositivo) de 
la parte superior de la 
pantalla y seleccione 
VST Connections 
(Conexiones VST). 
Haga clic en Inputs 
(Entradas) en la parte 
superior de la pantalla. 
Haga clic en la entrada 
titulada bajo la columna 
Bus Name (Nombre del 
bus) y pulse la tecla de 
eliminar en su teclado 
para eliminarlo. La 
ventana de conexiones VST debe quedar ahora vacía. A continuación, creará un bus de entrada 
mono. Haga clic en el botón Add Input Bus (Agregar bus de entrada). Asigne nombre al valor 
predeterminado y haga clic en OK. Cierre la ventana VST Connections. 

7. Haga clic derecho en el área azul oscuro del proyecto principal y seleccione Add Audio Track 
(Agregar pista de audio). 

8. En la ventana Audio Track Configuration (Configuración de pista de audio), seleccione 1 – Mono 
y haga clic en OK. 

9. Active el botón Track Monitor (Monitor de pista) en la pista Mono, que se encuentra junto al 
botón Record Enable (Activar grabación). Haga clic en el botón Record (Grabar) de la parte 
superior de la ventana de Cubase, efectúe una prueba rápida y detenga la grabación.  

10. Rebobine hasta el comienzo de la pista, desactive el botón del monitor de pistas y pulse el botón 
de reproducir de la parte superior de la ventana de Cubase para oír lo que acaba de grabar.  

 
 
Nota: Para evitar tener que configurar VST Audio System y VST Connections cada vez que abra 
Cubase, puede guardar su configuración como plantilla yendo a File> Save as Template (Archivo > 
Guardar como plantilla). Luego, cuando reabra Cubase, su plantilla aparece en la lista Project 
Templates (Plantillas del proyecto). 
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GUIDE D’UTILISATION SIMPLIFIÉ 
(FRANÇAIS) 
 
1. Assurez-vous que tous les articles énumérés dans le 

contenu de la boîte de ce guide sont inclus dans la 
boîte. 

2. VEUILLEZ LIRE LE LIVRET DES CONSIGNES DE 
SÉCURITÉ AVANT D'UTILISER LE PRODUIT. 

3. Placez le produit dans un endroit approprié à son 
utilisation. 

 
 
 
 
 
 

INSTALLATION DU MICRO 
 
Pour installer le micro dans la 
caisse de résonance de votre 
guitare : 
1. Dévissez soigneusement les 

bagues du micro dans le sens 
des aiguilles d’une montre à 
l’aide d’un tournevis.  

2. Placez le micro dans la rosace, 
près de la fin de la touche.  

3. Revissez les bagues du micron 
dans le sens inverse des 
aiguilles d’une montre. 

 
 
 
 

CONTENU DE LA BOÎTE
 Micro à simple bobinage pour 

guitare acoustique  
 Câble GuitareLink USB pour 

guitare 
 Guide d’utilisation simplifié 
 Consignes de sécurité et 

informations concernant la 
garantie 
DVD Cubase LE 
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SCHÉMA DE CONNEXION 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Avant de commencer, assurez-vous que votre ordinateur dispose de la configuration système 
requise suivante : 
• Windows : Microsoft Windows XP (SP2) / Vista (32 ou 64 bits) / 7 (32 ou 64 bits) sur Pentium IV ou 
Athlon XP 1,6 GHz ou supérieur (recommandé) 
• Mac : Mac OS X 10.5 ou ultérieure 
• 1 Go de mémoire vive (RAM) ou plus (recommandé) 
• Carte son (compatibilité AC97) 
• 1 Go Mo d’espace disque libre 
• Lecteur DVD-ROM (pour l’installation du logiciel) 
• 1 port USB 2.0 disponible (de préférence sur le panneau arrière de l’ordinateur) 
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LATENCE AUDIO 
 
La latence est le temps que met l’ordinateur à traiter les données entrantes et à produire un son. Plus 
faible est la latence, plus l'ordinateur répond rapidement aux commandes et émet un signal. 
Si vous éprouvez un délai entre le moment que vous jouez et que l’ordinateur reproduise un son, nous 
vous recommandons d'ajuster les réglages « Préférences » du logiciel en vous assurant que les 
paramètres de latence de votre carte son (ou mémoire tampon) soient à un réglage bas, idéalement 
plus bas que 15-20 ms. 

 

1. ASIO INSTALLATION (WINDOWS) 
IVER INSTALLATION (WINDOWS USERS) 
1. Téléchargez gratuitement le pilote ASIO4ALL (Audio Stream Input/Output) pour PC de 
www.asio4all.com.  
2. Double-cliquez sur le fichier d'installation (.exe). 
3. Suivez les instructions à l’écran pour installer le pilote audio. 
 
2. CONFIGURATION AUDIO (WINDOWS AND MAC) 
 
Dans la plupart des cas, et surtout si vous utilisez Windows, l’AcousticLink sera automatiquement 
sélectionné comme appareil d’enregistrement par défaut par votre ordinateur. Si vous ne parvenez pas 
à enregistrer un signal audio avec l’AcousticLink, veuillez suivre les instructions ci-dessous selon votre 
système d’exploitation. 
Vous pouvez utiliser l’AcousticLink avec tout poste audio numérique logiciel ou logiciel 
d’enregistrement qui prend en charge les périphériques audio USB. Assurez-vous d’abord que le 
logiciel est configuré de manière à recevoir de l'audio via l’AcousticLink. Pour de plus amples 
informations, veuillez consulter le guide d’utilisation du logiciel.   
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WINDOWS 7 
 
1. Cliquez sur Démarrer   Panneau de configuration  Matériel et audio  Son.   

2. Cliquez sur l’onglet « Enregistrement ». 

3. Assurez-vous que Microphone – Périphérique audio USB C-Media est le périphérique par 
défaut, puis cliquez sur « OK ».  

4. Assurez-vous que la carte de son interne est le périphérique par défaut, puis cliquez sur « OK ». 

 
 WINDOWS VISTA 
 
1. Cliquez sur Démarrer  Panneau de configuration  Son.  (Si vous ne voyez pas Son, 

sélectionnez « Basculer vers l’affichage classique » et le panneau de configuration Son devrait 
s'afficher.) 

2. Cliquez sur l’onglet 
« Enregistrement ». 

3. Assurez-vous que Microphone – Périphérique audio USB C-Media est le périphérique 
d’enregistrement par défaut. 

4. Assurez-vous que la carte de son interne est le périphérique par défaut, puis cliquez sur « OK ». 

 WINDOWS XP 
 
1. Cliquez sur Démarrer  Panneau de configuration  Sons et périphériques audio. 
2. Cliquez sur l’onglet « Audio ». 
3. Assurez-vous que sous « Enregistrement audio », Périphérique audio USB C-Media est le 

périphérique d’enregistrement par défaut. 
4. Assurez-vous que sous « Enregistrement audio », la carte de son interne (p. ex., SoundMax, 

Conexant, etc.) est le périphérique par défaut, puis cliquez sur « OK ». 
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MAC (OSX 10.5) 
 
1. Cliquez sur le bureau Mac afin de faire 

apparaître le Finder dans le coin supérieur 
gauche de l’écran. 

2. Cliquez sur le menu Aller dans le haut de 
l’écran et sélectionnez Utilitaires. 

3. Double-cliquez sur Configuration audio et 
MIDI dans la fenêtre qui apparaît. 

4. À partir du menu Audio dans le haut de 
l’écran, sélectionnez « Ouvrir l’éditeur de 
périphérique agrégé ». 

5. Cliquez sur le signe + pour créer un 
périphérique agrégé.  

6. Cochez les cases USB PnP Sound Device et 
Sortie intégrée, puis cliquez sur Terminé. 

7. Dans l’onglet « Périphériques audio » sous 
« Réglages du système », sélectionnez 
Périphérique agrégé comme Entrée par 
défaut.  

8. Sélectionnez ensuite Sortie intégrée comme 
Sortie par défaut puis fermez la fenêtre. 
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MAC (OSX 10.6) 
 
Configurez l’Acousticlink comme l’appareil 
d’enregistrement par défaut.  
 
1. Cliquez sur le bureau Mac afin de faire 

apparaître le Finder dans le coin supérieur 
gauche de l’écran. 

2. Cliquez sur le menu Aller dans le haut de 
l’écran et sélectionnez Utilitaires. 

3. Double-cliquez sur Configuration audio et 
MIDI dans la fenêtre qui apparaît. 

4. À partir de l’utilitaire de Configuration audio 
et MIDI, cliquez sur le menu Fenêtre dans le 
haut de l’écran et sélectionnez « Afficher la 
fenêtre Audio ».  

5. Cliquez le bouton + dans la fenêtre qui 
apparaît afin de créer un périphérique agrégé. 

6. Mettez le périphérique agrégé en surbrillance 
dans la fenêtre de gauche et cochez la case 
dans la fenêtre de droite pour USB PnP 
Sound Device et pour Sortie intégrée.  

7. Veuillez vous assurer que Périphérique 
agrégé est bien en surbrillance dans la fenêtre 
de gauche puis cliquez sur la roue dentée. 
Sélectionnez « Utiliser ce périphérique pour 
l’entrée audio ».  

8. Mettez l’option de sortie intégrée dans la 
fenêtre de gauche en surbrillance, puis cliquez 
sur la roue dentée et sélectionnez « Utiliser ce 
périphérique pour la sortie audio ».  

9. Fermez la fenêtre de configuration des 
périphériques audio. 
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3. CONFIGURATION DU LOGICIEL 
 
ACTIVATION DE CUBASE LE 5 
 
1. Installez Cubase LE 5.  
2. Assurez-vous que l’ordinateur dispose d’une connexion Internet afin de procéder à l’inscription et 

à l’activation de votre licence à l’aide du eLicenser Control Center (eLCC) auprès du serveur 
Steinberg.  

3. Assurez-vous d’avoir la toute dernière version du eLCC installée à partir de www.elicenser.net.  
4. Ouvrez le logiciel eLicense Control Center (eLCC) et notez bien le numéro Soft-eLicenser 

affiché.  Si aucun numéro n’est affiché, cliquez sur le menu « Aide » et sélectionnez « Mise à 
jour de la base de données de licences eLicenser ».  

5. Créez un compte utilisateur dans la section MySteinberg du site www.steinberg.net. Si vous en 
avez déjà un, procédez à l’étape 7. 

6. Vous recevrez un courriel vous demandant de confirmer la création de votre compte d’utilisateur 
afin de l’activer. Il vous suffira de cliquer sur le lien de confirmation dans le message. Si le lien 
ne fonctionne pas, copiez et collez le lien dans la barre d’adresse de votre navigateur. 

7. Accédez à votre compte utilisateur depuis MySteinberg, et cliquez sur « Activation et 
enregistrement des produits », sélectionnez « Cubase LE 5 » et puis « Permanent Activation ». 
Entrez votre Soft-eLicenser et sélectionnez le fabricant de votre matériel.  

8. Vous recevrez un courriel contenant le code d’activation.  
9. Lancez le logiciel eLicense Control Center.  Cliquez sur le bouton « Enter Activation Code » afin 

de télécharger la licence pour le produit Steinberg dans le Soft-eLicenser.  Entrez le code 
d’activation dans le champ correspondant. Suivez ensuite les instructions à l’écran. 

10. Une fois l’activation complétée, vous pouvez ouvrir Cubase et commencer à l’utiliser. 
 
Attention utilisateurs Windows : Si un message d’erreur de « permission » s’affiche lorsque vous 
lancez le logiciel, veuillez procéder aux étapes suivantes : 
1. Faites un clic droit sur l’icône Cubase sur le bureau. 
2. Sélectionnez Propriétés 
3. Cliquez sur l’onglet Compatibilité. 
4. Sous « Niveau de privilège », cochez la case « Exécuter ce programme en tant 

qu’administrateur ». 
5. Cliquez sur « Appliquer », puis sur « OK ». 
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INSTALLATION WINDOWS 
 
Une fois Cubase LE 5 installé et activé, veuillez 
suivre les étapes suivantes pour configurer le 
logiciel afin qu’il enregistrer le AcousticLink.  
 
1. Lancez Cubase LE 5. Si l’on vous invite à 

ouvrir un projet, refusez. 
2. À partir des menus, sélectionnez 

Périphériques  Configuration des 
périphériques… 

3. Dans le menu de Configuration des 
Périphériques, cliquez sur Système 
Audio VST.  

4. Dans le champ de sélection du pilote 
ASIO, sélectionnez ASIO4ALL.  
Répondez « Oui » lorsque l’on vous 
demande de confirmer le changement de 
pilote. Puis sélectionnez 
ASIO4ALL à partir de la fenêtre 
gauche et cliquez sur le bouton du 
Panneau de configuration dans le 
coin supérieur droit de la fenêtre. 

5. Cliquez sur la clé anglaise dans le 
coin inférieur droit et assurez-
vous que USB PnP Sound 
Device est coché comme 
périphérique d’entrée et que votre 
carte de son interne est cochée 
comme périphérique de sortie. 
Décochez tous les autres périphériques listés. 

6. Cliquez OK pour les deux fenêtres ouvertes, puis quittez et relancez Cubase afin que les 
modifications prennent effet.  

7. Dans Cubase, cliquez sur le menu Fichier Nouveau Projet et sélectionnez Créer, 
sélectionnez ensuite l’emplacement de sauvegarde. 
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8. Cliquez sur le menu Périphériques dans le haut de l’écran et sélectionnez VST Connexions. 

Cliquez sur Entrées dans le haut de la fenêtre. Cliquez sur l’entrée indiquée sous la colonne 
Nom de bus et appuyez sur la touche de suppression sur votre clavier afin de supprimer le bus 
d’entrée stéréo. La fenêtre des VST connexions devrait maintenant être vide. Créez un bus 
d’entrée mono en cliquant sur le bouton Ajouter Bus et en sélectionnant la configuration mono. 
Nommez les réglages et cliquez sur OK.  

9. Dans la colonne Périphériques Audio, sélectionnez ASIO4ALL. 
10. Dans la colonne Port Périphérique, sélectionnez « Périphérique Audio 1» (mono 1).  
11. Sous l’onglet Sorties, sélectionnez « ASIO4ALL » comme Périphérique Audio. 
12. Dans la colonne Port Périphérique, sélectionnez votre carte de son interne est cochée comme 

périphérique de sortie. Fermez ensuite la fenêtre VST Connections. 
13. Faites un clic droit sur la fenêtre principale du projet et sélectionnez Ajouter Piste Audio. 
14. Dans la fenêtre de configuration de la piste audio, sélectionnez « 1 – Mono » et cliquez sur OK. 
15. Acitvez le bouton de monitoring de piste sur la piste mono, à proximité du bouton d’activation de 

l’enregistrement. Cliquez sur le bouton d’enregistrement dans le haut de la fenêtre du Cubase, 
effectuez un essai rapide, puis arrêtez l’enregistrement.  

16. Retournez au début de la piste et cliquez sur le bouton de lecture dans le haut de la fenêtre 
Cubase afin d’écouter l’enregistrement. 

 
 
Remarque : Afin de ne pas devoir répéter la configuration du Système Audio VST et des VST 
Connections chaque fois que vous lancez Cubase, sauvegardez vos réglages comme modèle en 
cliquant sur Fichier  Enregistrer comme Modèle… Alors, chaque fois que vous lancerez Cubase, 
votre modèle s’affichera dans la liste des Modèles de Projet.  
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INSTALLATION MAC  
  
Une fois Cubase LE installé et activé, veuillez 
suivre les étapes suivantes pour configurer le 
logiciel afin qu’il enregistrer le AcousticLink.  
 
1. Lancez Cubase LE. Si l’on vous invite à 

ouvrir un projet, refusez. 
2. À partir des menus, sélectionnez 

Périphériques  Configuration des 
périphériques… 

3. Dans le menu de Configuration des 
Périphériques, cliquez sur Système Audio 
VST.  

4. À droite dans la fenêtre Configuration des 
Périphériques, dans la liste des pilotes 
ASIO, sélectionnez Périphérique agrégé. 
Cliquez sur OK. 

5. Dans Cubase, cliquez sur le menu 
Fichier Nouveau Projet et sélectionnez 
Créer, sélectionnez ensuite l’emplacement 
de sauvegarde.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

35 

 
6. Cliquez sur le menu Périphériques dans le haut de l’écran et sélectionnez VST Connexions. 

Cliquez sur Entrées dans le haut de la fenêtre. Cliquez sur l’entrée indiquée sous la colonne 
Nom de bus et appuyez sur la touche de retour arrière sur votre clavier afin de la supprimer. La 
fenêtre des VST connexions devrait maintenant être vide. Ensuite, vous devez créer un bus 
d’entrée mono. Cliquez sur le bouton Ajouter Bus d’entrée. Nommez les réglages et cliquez sur 
OK. Fermez ensuite la fenêtre VST Connections. 

7. Faites un clic droit sur la section bleu foncé du projet principal et sélectionnez Ajouter Piste 
Audio. 

8. Dans la fenêtre de configuration de la piste audio, sélectionnez 1 – Mono et cliquez sur OK. 
9. Acitvez le bouton de monitoring de piste sur la piste mono, à proximité du bouton d’activation de 

l’enregistrement. Cliquez sur le bouton d’enregistrement dans le haut de la fenêtre du Cubase, 
effectuez un essai rapide, puis arrêtez l’enregistrement.  

10. Retournez au début de la piste, désactivez le bouton de monitoring de piste et cliquez sur le 
bouton de lecture dans le haut de la fenêtre Cubase afin d’écouter l’enregistrement.  

 
Remarque : Afin de ne pas devoir répéter la configuration du Système Audio VST et des VST 
Connections chaque fois que vous lancez Cubase, sauvegardez vos réglages comme modèle en 
cliquant sur Fichier Enregistrer comme Modèle… Alors, chaque fois que vous lancerez Cubase, votre 
modèle s’affichera dans la liste des Modèles de Projet.  
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GUIDA RAPIDA (ITALIANO) 
 
1. Assicurarsi che tutti gli elementi elencati nella parte 

“Contenuti della confezione” siano inclusi. 
2. LEGGERE ATTENTAMENTE IL LIBRETTO DELLE 

ISTRUZIONI DI SICUREZZA PRIMA DI UTILIZZARE 
IL PRODOTTO. 

3. Collocare il prodotto in una posizione adeguata all’uso. 
 
 
 
 
 
 
 
 
 

INSTALLAZIONE DEL PICKUP 
 
Per installare il pickup a livello 
della buca della chitarra: 
 
1. Allentare delicatamente i 

morsetti del pickup in senso 
orario servendosi di un 
cacciavite.  

2. Posizionare il pickup nella 
buca, vicino al termine della 
tastiera.  

3. Stringere nuovamente i 
morsetti del pickup in senso 
antiorario. 

 
 
 

 Pickup per chitarra 
acustica single coil 

 Cavo USB per chitarra 
GuitarLink 

 Guida rapida 
 Istruzioni di sicurezza e 

garanzia 
 DVD recante il software 

Cubase LE 
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SCHEMA DEI COLLEGAMENTI 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Prima di iniziare, assicurarsi che il computer rispetti i seguenti requisiti di sistema: 
• Windows: Microsoft Windows XP (SP2) / Vista (32 o 64 bit) / 7 (32 o 64 bit) dotato di Pentium-IV o 
Athlon XP, 1,6GHz o superiore (consigliato) 
• Mac: Apple Mac OSX 10.5 o superiore 
• 1 GB RAM o superiore (consigliato) 
• Scheda audio (compatibile con AC97) 
• 1GB di spazio disponibile su hard disk 
• Lettore DVD-ROM (per l'installazione del software) 
• Una porta USB 2.0 disponibile (preferibilmente presente sul pannello posteriore del computer) 
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LA LATENZA AUDIO 
 
La “latenza” è il tempo che occorre alla scheda audio del vostro computer per elaborare i dati in arrivo 
ed emettere un suono. Più la latenza è bassa e più rapidamente il computer risponderà ai comandi 
emettendo suoni. 
Qualora si dovesse verificare un notevole ritardo tra il tempo di riproduzione e quello in cui il computer 
emette audio, si consiglia di recarsi alla linguetta “Preferiti” delle configurazioni del software per 
assicurarsi che la latenza della scheda audio (o buffer) sia impostata su un livello basso: idealmente, 
inferiore a 15-20ms. 

1. INSTALLAZIONE DI ASIO (WINDOWS) 
IVER INSTALLATION (WINDOWS USERS) 
1. Scaricate il driver gratuito ASIO4ALL (Audio Stream Input/Output) per PC alla pagina 
www.asio4all.com. 
2. Fare doppio clic sul file di installazione (.exe). 
3. Seguire le istruzioni su schermo per installare il driver audio. 
 
2. CONFIGURAZIONE AUDIO (WINDOWS AND MAC) 
 
Nella maggior parte dei casi (soprattutto se si utilizza Windows) AcousticLink verrà selezionato 
automaticamente come dispositivo di registrazione predefinito del computer. Qualora fosse impossibile 
registrare audio con AcousticLink, seguire le istruzioni di cui sotto relative al vostro sistema operativo. 
È possibile utilizzare AcousticLink con qualsiasi workstation audio digitale o software di registrazione 
che supporti dispositivi audio USB. Assicurarsi che il programma di software audio sia configurato per 
ricevere audio via AcousticLink. Per maggiori informazioni, consultate il manuale del vostro software.   
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WINDOWS 7 
 
1. Recarsi su Start  Pannello di controllo  Hardware e suoni  Audio.   

2. Selezionare la scheda “Registrazione”. 

3. Assicurarsi che Microfono – C-Media USB Audio Device sia selezionato quale periferica 
predefinita, quindi cliccare su “OK”.  

4. Assicurarsi che la scheda audio interna sia impostata quale periferica di riproduzione predefinita, 
quindi cliccare su “OK.” 

 
 WINDOWS VISTA 
 
1. Recarsi su Start  Pannello di controllo  Audio.  (Se non si visualizza Audio, selezionare 

“Switch to Classic View” (Visualizzazione classica), e il pannello di controllo Audio dovrebbe 
diventare disponibile.) 

2. Selezionare la scheda 
“Registrazione”. 

3. Assicurarsi che Microfono – C-Media USB Audio Device sia selezionato quale periferica di 
registrazione predefinita. 

4. Assicurarsi che la scheda audio interna sia impostata quale periferica di riproduzione predefinita, 
quindi cliccare su “OK.” 

 WINDOWS XP 
 
1. Recarsi su Start  Pannello di controllo  Suoni e periferiche audio. 
2. Fare clic sulla linguetta “Audio”. 

3. Sotto “Sound Recording”, assicurarsi che C-Media USB Audio Device sia selezionato come 
periferica di registrazione predefinita. 

4. Sotto “Sound Recording”, assicurarsi che la scheda audio interna (vale a dire SoundMax, 
Conexant, ecc.) sia selezionata quale periferica di riproduzione predefinita, quindi cliccare su 
“OK.” 
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MAC (OSX 10.5) 
 
1. Cliccare sul desktop del Mac in modo che il 
Finder sia visualizzato nella parte superiore sinistra 
dello schermo. 
2. Selezionare il menu Go dalla parte superiore dello 
schermo e scegliere Utilities. 
3. Nella finestra che si apre, fare doppio clic su 
Audio MIDI Setup. 
4. Nel menu Audio, selezionare Open Aggregate 
Device Editor. 
5. Cliccare sul segno + per creare un Aggregate 
Device.  
6. Inserire un segno di spunta nelle caselle per USB 
PnP Sound Device e Built-in Output (uscita 
incorporata) e cliccare su Fatto. 
7. Nella scheda “Audio Devices” sotto “System 
Settings,” selezionare Aggregate Device come 
ingresso predefinito (Default Input).  
8. Come uscita predefinita (Default Output), 
selezionare Built-in Output quindi chiudere la 
finestra. 
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MAC (OSX 10.6) 
 
 Impostare l'Acousticlink come dispositivo di 
riproduzione predefinito:  
 
1. Cliccare sul desktop del Mac in modo che il 
Finder sia visualizzato nella parte superiore 
sinistra dello schermo. 
2. Selezionare il menu Go dalla parte superiore 
dello schermo e scegliere Utilities. 
3. Nella finestra che si apre, fare doppio clic su 
Audio MIDI Setup. 
4. Una volta che Audio MIDI Setup è aperto, 
selezionare il menu Window in cima allo 
schermo e selezionare ’Show Audio Window’.  
5. Nella finestra che si apre, cliccare il tasto + per 
creare un dispositivo aggregato. 
6. Evidenziare il dispositivo aggregato (Aggregate 
Device) nel pannello di sinistra e inserire un 
segno di spunta nella casella sul pannello di 
destra per USB PnP Sound Device e per Built-
in Output.  
7. Assicurarsi che il Aggregate Device sia 
evidenziato nel pannello di sinistra e cliccare sulla 
ruota dentata. Selezionare ‘Use this device for 
sound input’ (servirsi di questo dispositivo per 
l'ingresso audio).   
8. Evidenziare l'opzione Built-In output (uscita 
incorporata) nel pannello di sinistra, cliccare sulla 
ruota dentata e selezionare ‘Use this device for 
sound output’ (servirsi di questo dispositivo per 
l'uscita audio).  
9. Chiudere la finestra Audio Setup. 
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3. CONFIGURAZIONE DEL SOFTWARE 
 
ATTIVAZIONE DEL CUBASE LE 5 
 
1. Installare il Cubase LE 5.  
2. Assicurarsi che il computer disponga di un collegamento a Internet funzionante per attivare la 

licenza, in quanto l'eLicenser Control Center (eLCC) si deve registrare con il server di licenza 
Steinberg.  

3. Asicurarsi di aver installato l'ultima versione dell'eLCC scaricandola da www.elicenser.net.  
4. Aprire il software eLicense Control Center (eLCC) e prendere nota del numero di Soft-eLicenser. 

Se non viene visualizzato il numero, cliccare sul menu "Support" (assistenza) e selezionare 
"Update eLicenser License Database". 

5. Creare un account utente nell'area MySteinberg all'indirizzo www.steinberg.net. Se già si 
dispone di un account, passare alla Fase 7. 

6. Verificare l'e-mail e attivare l'account utente cliccando sul link presente nell'e-mail di conferma. 
Se il link non funziona, copiare e incollare il link stesso nella barra degli indirizzi del browser. 

7. Effettuare il login al proprio account MySteinberg e cliccare su "Activation & Reactivation", 
scegliere "Cubase LE 5" e selezionare "Permanent Activation" (attivazione permanente). Inserire 
il Soft-eLicenser e scegliere il produttore dell'hardware.  

8. Si riceverà un'e-mail contenente il codice di attivazione.  
9. Lanciare il software eLicenser Control Center. Cliccare sul pulsante "Enter Activation Code" 

(inserisci codice di attivazione) per scaricare la licenza per il tuo prodotto Steinberg nel Soft-
eLicenser. Inserire il codice di attivazione richiesto nel campo corrispondente. Seguire le 
istruzioni su schermo. 

10. Dopo aver attivato il software, è possibile aprire il Cubase e iniziare a utilizzarlo. 
 
Attenzione, utenti Windows: se si visualizza un messaggio di errore "permissions" (permessi) 
quando si cerca di aprire il software, procedere come segue: 
1. Fare clic col tasto destro del mouse sull'icona Cubase presente sul Desktop. 
2. Selezionare Properties (proprietà). 
3. Selezionare la scheda Compatibility (compatibilità). 
4. Sotto "Privilege Level" (livello privilegi) spuntare la casella che dice "Run this program as an 

administrator" (lanciare questo programma da amministratore). 
5. Cliccare su "Applica", quindi su "OK". 
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CONFIGURAZIONE WINDOWS 
 
Una volta installato e attivato il Cubase LE 5, 
procedere come segue per configurare il 
software per registrare con AcousticLink.   
 
1. Aprire Cubase LE 5. Se viene richiesto di 

aprire un progetto, annullare per adesso. 
2. Dai menu selezionare Devices  Device 

Setup. 
3. In Device Setup cliccare su VST Audio 

System.  
4. Nella casella a cascata dei driver ASIO, 

scegliere ASIO4ALL. Quando viene 
richiesto di attivare il driver, selezionare 
‘Yes’. Quindi selezionare ASIO4ALL dal 
pannello di sinistra e cliccare sul tasto 
Pannello di controllo nella parte superiore 
destra della finestra. 

5. Cliccare sull'immagine della 
chiave inglese nell'angolo 
inferiore destro e assicurarsi che 
USB PnP Sound Device Device 
sia selezionato per il dispositivo di 
ingresso e che la scheda audio 
interna sia selezionata come 
dispositivo di uscita. Eliminare il 
segno di spunta da qualsiasi altro 
dispositivo elencato. 

6. Cliccare su OK per le due finestre 
che sono aperte e chiudere e riaprire il Cubase per rendere effettivi i cambiamenti.  

7. In Cubase, cliccare su File New Project, selezionare Empty (vuoto), e scegliere dove si 
desidera salvare il progetto. 

 
 
 



  

44 

 
8. Cliccare sul menu Device in cima allo schermo e 

selezionare VST Connections. Cliccare su Inputs 
(ingressi) in cima alla finestra. Cliccare sull'ingresso 
intitolato sotto alla colonna Bus Name (nome bus) e 
premere il tasto canc della tastiera per cancellare la bus 
Stereo In. La finestra VST connections dovrebbe ora essere 
vuota. Creare un bus di ingresso Mono cliccando sul tasto 
Add Bus e selezionando la configurazione Mono. Nominare 
il preset, e cliccare su OK.  

9. Sotto la colonna Audio Device, selezionare ASIO4ALL. 
10. Nella colonna Device port, selezionare ‘Sound Device 1’ 

(Mono in).  
11. Cliccare sulla scheda Outputs (uscite), selezionare 

‘ASIO4ALL’ come dispositivo audio. 
12. Nella colonna Device port, selezionare la scheda audio 

interna come dispositivo di uscita. Chiudere la finestra 
VST Connections (connessioni VST). 

13. Fare clic col pulsante destro del mouse nella finestra 
principale del progetto e scegliere Add Audio Track 
(aggiungi traccia audio). 

14. Nella finestra Audio Track Configuration, 
selezionare ‘1 – Mono’ e cliccare su OK. 

15. Attivare il tasto Track Monitor sulla traccia Mono, 
accanto al tasto Record Enable. Cliccare sul tasto 
Record in cima alla finestra del Cubase, 
effettuare un test rapido e interrompere la 
registrazione.  

16. Riavvolgere all'inizio della traccia e premere il 
tasto play in cima alla finestra del Cubase per 
ascoltare ciò che si ha appena registrato. 

 
Nota bene: per evitare di dover impostare VST Audio System e VST Connections ogni volta che si 
apre il Cubase, si possono salvare le proprie configurazioni come template recandosi su File> Save as 
Template. Quindi, quando si apre Cubase, il modello da voi salvato comparirà nell'elenco dei template 
di progetto.  
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CONFIGURAZIONE PER MAC  
  
Una volta installato e attivato il Cubase LE 5, 
procedere come segue per configurare il software 
per registrare con AcousticLink.   
 
1. Aprire il Cubase LE. Se viene richiesto di 

aprire un progetto, annullare per adesso. 
2. Dai menu, selezionare  Devices> Device 

Setup. 
3. In Device Setup cliccare su VST Audio 

System.  
4. Nell'elenco dei driver ASIO sul lato destro 

di Device Setup, selezionare Aggregate 
Device. Cliccare su OK. 

5. In Cubase, cliccare su File New Project, 
selezionare Empty, e scegliere dove si 
desidera salvare il progetto.  

6. Cliccare sul menu Device in cima allo 
schermo e selezionare VST Connections. 
Cliccare su Inputs (ingressi) in cima alla 
finestra. Cliccare 
sull'ingresso intitolato 
sotto la colonna Bus 
Name (nome bus) e 
premere il tasto canc 
sulla tastiera per 
cancellarlo. La finestra 
dei collegamenti VST ora 
dovrebbe essere vuota. 
Quindi, verrà creata una 
bus di ingresso Mono. 
Cliccare sul tasto Add 
Input Bus (aggiungi bus 
ingresso). Nominare il 
preset e cliccare su OK. Chiudere la finestra VST Connections (connessioni VST). 
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7. Fare clic col destro nell'area blu scura del progetto principale e scegliere Add Audio Track 

(aggiungi traccia audio). 
8. Nella finestra Audio Track Configuration selezionare 1 – Mono e cliccare su OK. 
9. Attivare il tasto Track Monitor sulla traccia Mono, accanto al tasto Record Enable. Cliccare sul 

tasto Record in cima alla finestra del Cubase, effettuare un test rapido e interrompere la 
registrazione.  

10. Riavvolgere all'inizio della traccia, disattivare il tasto track monitor e premere il tasto play in cima 
alla finestra del Cubase per ascoltare ciò che si ha appena registrato.  

 
Nota bene: per evitare di dover impostare VST Audio System e VST Connections ogni volta che si 
apre il Cubase, si possono salvare le proprie configurazioni come template recandosi su File> Save as 
Template. Quindi, quando si apre Cubase, il modello da voi salvato comparirà nell'elenco dei template 
di progetto. 
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SCHNELLSTART-ANLEITUNG (DEUTSCH) 
 
1. Stellen Sie sicher, dass alle im Lieferumfang aufgelisteten 

Teile in der Verpackung enthalten sind. 
2. LESEN SIE DIE SICHERHEITSHINWEISE, BEVOR SIE 

DAS PRODUKT VERWENDEN. 
3. Stellen Sie das Gerät an einen für den Betrieb geeigneten 

Standort. 
 

MONTAGE DES PICKUPS 
 
So montieren Sie den Pickup am Schallloch Ihrer Gitarre: 
 
1. Lösen Sie die Pickup-Klemmen vorsichtig mit einem 

Schraubendreher im Uhrzeigersinn.  
2. Positionieren Sie den Pickup am 

Schallloch, nahe dem Ende des 
Bunds.  

3. Ziehen Sie die Pickup-Klemmen 
gegen den Uhrzeigersinn wieder 
fest. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Einzelne Rolle akustische 
Gitarre-Erholung  

 GuitarLink USB Gitarre-
Kabel 

 Schnellstart-Anleitung 
 Sicherheitshinweise und 

Garantieinformationen 
 DVD software Cubase LE 
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ANSCHLUSSÜBERSICHT 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Bevor Sie beginnen, vergewissern Sie sich, dass Ihr Computer folgende Systemanforderungen 
erfüllt: 
• Windows: Microsoft Windows XP (SP2) / Vista  (32 oder 64 Bit) / 7 (32 oder 64 Bit) mit Pentium-IV 
oder Athlon XP, 1,6 GHz oder höher (empfohlen) 
• Mac: Apple Mac OSX 10.5 oder höher 
• 1 GB RAM oder höher (empfohlen) 
• Soundkarte (AC97-kompatible Soundkarte) 
• 1 GB freier Festplattenspeicherplatz 
• DVD-ROM-Laufwerk (für Software-Installation) 
• Ein freier USB 2.0-Anschluss (vorzugsweise auf der Rückseite des Computers) 
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ZUR AUDIO-LATENZ 
 
"Latenz" ist die Zeit, die die Computer-Soundkarte benötigt, um eingehende Daten zu verarbeiten und 
ein Audiosignal auszugeben. Je niedriger die Latenz ist, desto schneller wird Ihr Computer auf Befehle 
reagieren und Audiosignale ausgeben. 
Wenn Sie eine erhebliche Verzögerung zwischen dem Zeitpunkt, an dem Sie eine Note spielen, und 
dem Zeitpunkt, an dem der Computer den Sound ausgibt, feststellen, empfehlen wir Ihnen, zu den 
"Einstellungen" Ihrer Software zu navigieren und sicherzustellen, dass die Latenz (Puffer) Ihrer 
Soundkarte auf einen niedrigen Wert eingestellt ist  - im Idealfall unter 15-20ms. 

 
1. ASIO INSTALLATION (WINDOWS) 
IVER INSTALLATION (WINDOWS USERS) 
1. Laden Sie sich den kostenlosen ASIO4ALL (Audio Stream Input/Output) Treiber für von der 
Webseite www.asio4all.com herunter. 
2. Doppelklicken Sie auf die Installationsdatei (.exe). 
3. Befolgen Sie die Anweisungen am Bildschirm, um den Audiotreiber zu installieren. 
 
2. AUDIO SETUP (WINDOWS AND MAC) 
 
In den meisten Fällen (vor allem, wenn Sie Windows verwenden) wird AcousticLink automatisch als 
Standard-Aufnahmegerät Ihres Computers ausgewählt werden. Wenn Sie feststellen, dass Sie kein 
Audio mit AcousticLink aufnehmen können, folgen Sie den unten angegebenen Anweisungen für Ihr 
Betriebssystem. 
Sie können AcousticLink mit jeder digitalen Audio-Workstation oder Aufnahme-Software verwenden, 
die USB-Audiogeräte unterstützt. Achten Sie darauf, dass Ihr Audio-Software-Programm so 
eingerichtet ist, dass es Audio über AcousticLink empfangen kann. Weitere Informationen finden Sie in 
Ihrem Software-Handbuch.  
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WINDOWS 7 
 
1. Wählen Sie Startmenü  Systemsteuerung  Hardware und Sound  Ton.  

2. Wählen Sie die Registerkarte "Aufnahme". 

3. Stellen Sie sicher, dass Mikrofon - C-Media USB Audio Device als Standard-Gerät eingestellt 
ist und klicken dann auf "OK".  

4. Stellen Sie sicher, dass Ihre interne Soundkarte als Standard-Wiedergabegerät eingestellt ist 
und klicken dann auf "OK." 

 
 WINDOWS VISTA 
 
1. Wählen Sie Startmenü  Systemsteuerung  Hardware und  Ton.  (Wenn Sie Ton nicht 

sehen können, wählen Sie "Auf klassische Ansicht wechseln".  Das Fenster Sound-
Eigenschaften sollte nun verfügbar sein.) 

2. Wählen Sie die Registerkarte "Aufnahme". 

3. Stellen Sie sicher, dass Mikrofon - C-Media USB Audio Device als Standard-Aufnahmegerät 
eingestellt ist.  

4. Stellen Sie sicher, dass Ihre interne Soundkarte als Standard-Wiedergabegerät eingestellt ist 
und klicken dann auf "OK." 

 
WINDOWS XP 
 
1. Wählen Sie Startmenü  Systemsteuerung  Sounds und Audiogeräte. 
2. Klicken Sie auf die Registerkarte "Audio". 

3. Unter "Aufnahme" stellen Sie sicher, dass C-Media USB Audio Device als Standard-
Aufnahmegerät ausgewählt ist. 

4. Unter "Aufnahme" stellen Sie sicher, dass Ihre interne Soundkarte (z.B. SoundMax, Conexant 
etc.) als Standard-Wiedergabegerät ausgewählt ist und klicken auf "OK". 
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MAC (OSX 10.5) 
 
1. Klicken Sie auf den Mac-Desktop, so dass Finder 
in der oberen linken Bildschirmhälfte aufscheint. 
2. Wählen Sie das Go-Menü aus der oberen 
Bildschirmhälfte und wählen Sie Dienstprogramme. 
3. Im sich öffnenden Fenster doppelklicken Sie auf 
Audio-MIDI-Setup. 
4. Im Audio-Menü wählen Sie Aggregate Device 
Editor Öffnen. 
5. Klicken Sie auf das Zeichen +, um ein Aggregate 
Device zu erstellen.  
6. Setzen Sie ein Häkchen in das Kästchen für USB 
PnP Sound Device und Integrierter Output und 
klicken Sie auf Fertig. 
7. In der Registerkarte "Audio-Geräte" unter 
"Systemeinstellungen" wählen Sie Aggregate 
Device als Ihre Standardeingabe aus.  
8. Als Standardausgabe wählen Sie Integrierter 
Output und schließen danach das Fenster. 
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MAC (OSX 10.6) 
 
Stellen Sie Acousticlink als Ihr Standard-
Aufnahmegerät ein:  
 
1. Klicken Sie auf den Mac-Desktop, so dass 
Finder in der oberen linken Bildschirmhälfte 
aufscheint. 
2. Wählen Sie das Go-Menü aus der oberen 
Bildschirmhälfte und wählen Sie 
Dienstprogramme. 
3. Im sich öffnenden Fenster doppelklicken Sie 
auf Audio-MIDI-Setup. 
4. Sobald das Dienstprogramm Audio-MIDI-
Setup geöffnet ist, wählen Sie das Fenstermenü 
am oberen Rand des Bildschirms und wählen 
'Audio-Fenster zeigen'.  
5. Im sich öffnenden Fenster klicken Sie die Taste 
+, um ein Aggregate Device zu erstellen. 
6. Markieren Sie das Aggregate Device im linken 
Bereich und setzen dann ein Häkchen in das 
Kästchen 
 im rechten Bereich für USB PnP Sound Device 
und für Integrierter Output.  
7. Vergewissern Sie sich, dass Aggregate Device 
im linken Fenster markiert ist und klicken dann 
auf das Zahnrad. Wählen Sie "Dieses Gerät als 
Eingabegerät verwenden".  
8. Markieren Sie die Option Integrierter Output im 
linken Bereich, klicken auf das Zahnrad und 
wählen "Dieses Gerät für die Ausgabe 
verwenden".  
9. Schließen Sie das Fenster Audio-Setup. 
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3. EINRICHTEN DER SOFTWARE 
 
AKTIVIEREN VON CUBASE LE 5 
 
1. Installieren Sie Cubase LE 5.  
2. Stellen Sie sicher, dass Ihr Computer über eine funktionierende Internetverbindung verfügt, um 

die Lizenz zu aktivieren, da sich das eLicenser Control Center (eLCC) am Steinberg-Lizenz-
Server registrieren muss.  

3. Stellen Sie sicher, dass Sie die neueste Version von eLCC von www.elicenser.net installiert 
haben.  

4. Öffnen Sie die eLicense Control Center (eLCC) Software und notieren Sie Ihre Soft-eLicenser-
Nummer. Wenn Sie Ihre Nummer nicht sehen, klicken Sie auf das "Support"-Menü und wählen 
"eLicenser Lizenz-Datenbank aktualisieren."  

5. Erstellen Sie ein Benutzerkonto unter MySteinberg auf www.steinberg.net. Wenn Sie bereits ein 
Konto haben, fahren Sie bitte mit Schritt 7 fort. 

6. Checken Sie Ihre E-Mail und aktivieren Sie Ihr Benutzerkonto, indem Sie dem Link in der 
Bestätigungsmail folgen. Wenn der Link nicht funktioniert, kopieren Sie den Link in Ihre Browser-
Adressleiste. 

7. Loggen Sie sich in Ihr MySteinberg Konto ein und klicken Sie auf "Aktivierung & Reaktivierung". 
Wählen Sie "Cubase LE 5" und anschließend "Permanente Aktivierung". Geben Sie Ihre Soft-
eLicenser Nummer ein, und wählen Sie den Hersteller Ihrer Hardware aus.  

8. Sie erhalten eine E-Mail mit dem Aktivierungscode.  
9. Starten Sie die eLicenser Control Center Software. Klicken Sie auf die Schaltfläche 

"Aktivierungscode eingeben", um die Lizenz für Ihr Steinberg-Produkt in den Soft-eLicenser zu 
laden. Geben Sie den erforderlichen Aktivierungscode in das entsprechende Feld ein. Befolgen 
Sie die Anweisungen auf dem Bildschirm. 

10. Nach der Aktivierung der Software können Sie Cubase öffnen und sofort nutzen. 
 
Windows-Benutzer - bitte beachten Sie: Wenn Sie beim Versuch die Software zu öffnen eine 
"Berechtigungs"-Fehlermeldung erhalten, gehen Sie folgendermaßen vor: 
1. Klicken Sie mit der rechten Maustaste auf das Cubase-Symbol auf Ihrem Desktop. 
2. Wählen Sie Eigenschaften. 
3. Wählen Sie die Registerkarte Kompatibilität. 
4. Unter "Berechtigungsstufe" aktivieren Sie das Kontrollkästchen "Programm als Administrator 

ausführen." 
5. Klicken Sie auf "Übernehmen" und anschließend auf "OK". 
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WINDOWS SETUP 
 
Sobald Cubase LE 5 installiert und aktiviert ist, 
gehen Sie folgendermaßen vor, um die Software 
so zu konfigurieren, dass sie mit AcousticLink 
aufnimmt.  
 
1. Öffnen Sie Cubase LE 5. Wenn Sie 

aufgefordert werden, ein Projekt zu öffnen, 
dann brechen Sie dies vorerst ab. 

2. Wählen Sie aus den Menüs Geräte   
Geräte-Setup. 

3. Im Geräte-Setup klicken Sie auf VST 
Audio System.  

4. In der Dropdown-Box des ASIO-Treibers 
wählen Sie ASIO4ALL. Wenn Sie gefragt 
werden, ob Sie den Treiber wechseln 
möchten, antworten Sie mit 'Ja'. Wählen 
Sie anschließend ASIO4ALL aus 
dem linken Fenster und klicken 
Sie auf die Schaltfläche 
Systemsteuerung oben rechts im 
Fenster. 

5. Klicken Sie auf das 
Schraubenschlüssel-Symbol in 
die rechten unteren Ecke und 
vergewissern Sie sich, dass USB 
PnP Sound Device Device als 
Eingabegerät und Ihre interne 
Soundkarte als Ausgabegerät gewählt ist. Deaktivieren Sie alle anderen hier aufgelisteten 
Geräte. 

6. Klicken Sie in beiden geöffneten Fenstern auf OK, schließen und öffnen Cubase erneut, damit 
die Änderungen übernommen werden.  

7. In Cubase, klicken Sie auf Datei Neues Projekt und wählen Leer. Wählen Sie dann, wo Sie Ihr 
Projekt speichern möchten.  
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8. Klicken Sie auf das Menü Gerät am oberen 

Bildschirmrand und wählen VST Verbindungen. 
Klicken Sie auf Eingänge am oberen Rand des 
Fensters. Klicken Sie auf den Eingang unter der Spalte 
Busnamen und drücken Sie die Taste Entfernen auf 
Ihrer Tastatur, um den Stereo In Bus zu löschen. Das 
Fenster VST-Verbindungen sollte nun leer sein. 
Erstellen Sie einen Mono-Eingang-Bus, indem Sie auf 
die Schaltfläche Bus Hinzufügen klicken und die 
Mono-Konfiguration auswählen. Benennen Sie 
die Voreinstellung, und klicken Sie auf OK.  

9. In der Spalte Audio-Gerät wählen Sie ASIO4ALL. 
10. In der Spalte Geräte-Port wählen Sie 'Sound 

Device 1' (Mono In).  
11. In der Registerkarte Ausgabe wählen Sie 

'ASIO4ALL' als Audio-Gerät. 
12. In der Spalte Geräte-Port wählen Sie Ihre interne 

Soundkarte als Ausgabegerät. Schließen Sie das 
Fenster VST-Verbindungen. 

13. Klicken Sie mit der rechten Maustaste in das Hauptfenster des Projekts und wählen Audio-
Track hinzufügen. 

14. Im Konfigurationsfenster für den Audio-Track wählen Sie '1 - Mono' und klicken auf OK. 
15. Aktivieren Sie im Mono-Track die Schaltfläche Track-Monitor neben der Schaltfläche Aufnahme 

Aktivieren. Klicken Sie auf die Schaltfläche Aufnahme im oberen Bereich des Cubase-Fensters, 
führen einen kurzen Test durch und beenden die Aufnahme.  

16. Springen Sie zurück zum Anfang des Tracks und drücken Sie die Wiedergabe-Taste am oberen 
Rand des Cubase-Fensters, um zu hören, was Sie gerade aufgenommen haben. 

 
Hinweis: Damit Sie das VST-Audiosystem und die VST-Verbindungen nicht jedesmal neu einstellen 
müssen, wenn Sie Cubase öffnen, können Sie Ihre Einstellungen als Vorlage speichern, indem Sie 
Datei> Als Vorlage Speichern wählen. Wenn Sie Cubase dann öffnen, erscheint Ihre Vorlage in der 
Liste der Projektvorlagen.  
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MAC SETUP  
  
Sobald Cubase LE installiert und aktiviert ist, 
gehen Sie folgendermaßen vor, um die Software 
so zu konfigurieren, dass sie mit AcousticLink 
aufnimmt.  
 
1. Öffnen Sie Cubase LE. Wenn Sie 

aufgefordert werden, ein Projekt zu öffnen, 
dann brechen Sie dies vorerst ab. 

2. Wählen Sie aus den Menüs Geräte > 
Geräte-Setup. 

3. Im Geräte-Setup klicken Sie auf VST 
Audio System.  

4. In der Liste der ASIO-Treiber auf der 
rechten Seite des Geräte-Setups wählen 
Sie Aggregate Device. Klicken Sie auf 
OK. 

5. In Cubase klicken Sie auf Datei Neues 
Projekt und wählen Leer. Wählen Sie 
dann, wo Sie Ihr Projekt speichern 
möchten.  
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6. Klicken Sie auf das Menü Gerät am oberen Bildschirmrand und wählen VST Verbindungen. 

Klicken Sie auf Eingänge am oberen Rand des Fensters. Klicken Sie auf den Eingang unter der 
Spalte Busnamen und drücken Sie die Taste Entfernen auf Ihrer Tastatur, um ihn zu löschen. 
Das Fenster VST-Verbindungen sollte nun leer sein. Anschließend erstellen Sie einen Mono-
Eingang-Bus. Klicken Sie auf die Schaltfläche Eingang-Bus hinzufügen. Benennen Sie die 
Voreinstellung, und klicken Sie auf OK. Schließen Sie das Fenster VST-Verbindungen . 

7. Klicken Sie mit der rechten Maustaste in den dunkelblauen Bereich des Haupt-Projekts und 
wählen Sie Audio-Track hinzufügen. 

8. Im Konfigurationsfenster für den Audio-Track wählen Sie 1 - Mono und klicken auf OK. 
9. Aktivieren Sie im Mono-Track die Schaltfläche Track-Monitor neben der Schaltfläche Aufnahme 

Aktivieren. Klicken Sie auf die Schaltfläche Aufnahme im oberen Bereich des Cubase-Fensters, 
führen einen kurzen Test durch und beenden die Aufnahme.  

10. Springen Sie zurück zum Anfang des Tracks, deaktivieren die Schaltfläche Track-Monitor und 
drücken die Wiedergabe-Taste am oberen Rand des Cubase-Fensters, um zu hören, was Sie 
gerade aufgenommen haben.  

 
Hinweis: Damit Sie das VST-Audiosystem und die VST-Verbindungen nicht jedesmal neu einstellen 
müssen, wenn Sie Cubase öffnen, können Sie Ihre Einstellungen als Vorlage speichern, indem Sie 
Datei> Als Vorlage Speichern wählen. Wenn Sie Cubase dann öffnen, erscheint Ihre Vorlage in der 
Liste der Projektvorlagen.  
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